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Know it Sooner Computer Training is located in Edmonton, 

Alberta, Canada and we travel all over to companies to train their 

staff.  

 

We consult, train classes and write manuals in Microsoft Excel, 

Word, PowerPoint and Outlook.  

 

We have a portable lab of laptops that allow us to bring the 

classroom to your site for the most effective training environment. 

 

If you feel you’ve had a positive training experience today, please 

pass our name on to friends, family or contacts you think would 

benefit from a training session. 

 

Please refer to our website for a copy of the exercises used in this 

manual. They are on the Downloads tab, Excel. 

 

Thank you for participating today. I hope to see you again soon! 

 

Joanne Swensrude 

Instructor 

Know It Sooner Computer Training 

www.knowitsooner.com 

Joanne@knowitsooner.com 

780-940-6772 
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Excel Level 1 

Introduction 
 
Excel Screen 
 
The Excel worksheet file, also referred to as a workbook, is an electronic spreadsheet that consists of a 
grid of columns and rows. There are 16,384 columns, labeled A through Z, AA through AZ, BA through 
BZ, and so on to XFD. There are 1,048,576 rows, starting at 1. 
 
Each Excel file can also include over 255 worksheets. The worksheet name, which defaults to Sheet 1, 
Sheet 2, and so on, appears on a tab at the bottom left of the workbook. 
 
The following diagram is of a standard Excel screen. Your version may look slightly different. 
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Some of the main components of the screen are discussed below. 
 
Quick Access Tool Bar Provide tools to access commonly used functions.  
 
Ribbon This holds many tabs that hold time saving buttons. For example, 

the Page Layout tab contains commands relating to setting up 
your print job. If you double click on one of the ribbon tabs, the 
ribbon will be minimized in order for you to maximize your work 
space. Double click it again to bring it back to normal size.  

 
Active Cell Highlighted by a rectangle. The address of the current cell appears 

in the Name Box. For example, A1 or C5. 
 
Column Headings  Columns are given letters of the alphabet as names. 
 
Row Indicator  Rows are given numbers as names. 
 
Sheet Tab  Identifies the Current Worksheet. 
 
Formula Bar Contains the cell contents. This will either be a label, number or 

formula. Appearing to the left of it is the Insert Function button 
(fx), used for creating functions. 

 

To add a button to your Quick Access Bar (the toolbar near the 
Office button or File menu), simply right click the button or menu 

item and choose Add to Quick Access Toolbar. 
 

This bar stays on your screen whenever you’re in the program, it 
never disappears! 
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Excel Cursors 

1. Selection Cursor: 

 
Click and drag to highlight multiple cells with this cursor, or click in a cell 
to select the single cell. 

2. Autofill Handle: 

 

Click and drag to fill in the other cells with content. It works differently 
depending on what you drag. For example, if you Autofill January, you will 
fill in the other cells with February, March, etc. 

3. Move Cursor: 

 

Click and drag the contents of the selected cell to any other cell. 

4. Selection Bar (I-Beam): 

 
Click to place the cursor into the Formula bar so that you can 
edit an equation or function. 

5. Column Width/Row Height Sizer: 

 
Click and drag in between columns or rows to resize them. 
 

 

 

Double click when you see 
this arrow and it will 
automatically size your 
column or row to 
accommodate 
the largest entry! 

6. Select Whole Column or Row: 

 

Click right on the Column heading or 
Row number to select the entire 
Column or Row. 
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Creating a Spreadsheet 
 
Worksheets are created by entering data into cells. Excel recognizes three types of data: Labels (text), 
Numbers, and Formulas. 
 

Labels 
 
Labels are usually titles or comments. i.e. headings. As you type entries they first appear in the format 
line. Once you press <Enter> or an arrow key they will appear in the actual cell. 
 
• Labels can begin with any character except those characters which begin numbers & formulas. 
 
• Labels can display across multiple columns if the columns are empty. If cells to the right of the 

label are blank, Excel displays the part of the label that overlaps those cells. If cells to the right 
of the label contain data, Excel truncates (cuts off) the label for cell display. 

 
• If the first character of the data is ', A-Z, a-z, Excel assumes the entry is a label. 

Numbers 
 
Numbers are composed of digits and, if necessary, a leading minus sign and/or a decimal point. 
 

• Numbers are automatically Right Justified. 
 

• Numbers can also be aligned to the left, right or centre. 
 

• Do not include any spaces or text in numbers. 
 

• Numbers start with one of the following: 
 

1, 2, 3, 4, 5, 6, 7, 8, 9 
 

• Numbers are considered to be values. 
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Formulas 
 
Formulas are entries that calculate data. The result of a formula is a value. 
 
The calculation can be a simple mathematical operation, such as subtracting one number from 
another, or a more complicated operation, such as determining a mortgage payment. 
 

• Formulas are used rather than typing in actual numbers. 
 

• Are arithmetic expressions referencing other cells. 
 

• Formulas usually start with = 
 

• Make sure you begin the formula where you want the answer to be. 
 

• When entering the formula by the pointing method, you will need to press <Enter> only 
once, at the very end of the formula. 

 
• You can also type in only the cell reference after = (i.e. =B4) if you just want the contents of 

one cell to be in another. (i.e. carrying forward a total). 

Arithmetic Operators 
 

Simple Formulas  Order of Operation 

Always start with an = sign  1.  (brackets) 

+ Addition  2.  * / 

- Subtraction  3.  + - 

* Multiply     

/ Divide    

 
Examples: 
 
=A1 + A2 
=A4 * 7% 
=D14-D15 
=(B3 + B4) /2 
=B10+B11-B12 
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Creating a Formula 
 

Open TRIP PLANNER.XLSX 

 

 

1. In cell D4, we will multiply the quantity by the price to calculate the subtotal of that expense. 
 
On a calculator, you could input:  2 X 350 
 
In Excel, we would enter an equal sign and substitute the numbers for cell names: 
=B4 * C4 and press Enter. 

2. Since the next three cells (D4:D10), will have relatively the same formula, 
click on cell D4 and find the Autofill handle on the bottom right corner of 
the cell and click and drag down to cell D10. 
 
This copies and adjusts the formula down to the other cells! 

3. Change the contents of cells B4. Notice the annual cost changes for that magazine. 

 

NOTE: You can also use the Point and Click Method to enter a formula. 
 
To create =B4*C4: 
- Click on cell D4 
 - Type the = sign on your keyboard 
- Click on cell B4 
- Type the * sign on the keyboard 
- Click on C4 
- Press Enter 

4. Create the other formulas: 
GST (E4):  =D4*5% 
Total (F4): =D4+E4  
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Totaling Cells (SUM function) 

It is very easy to total a column or row of numbers.  

1. Click on the cell where you want the total to go. (D12) 

2. Click on the AUTOSUM tool on the Home tab on your Ribbon.   

3. Excel "guesses" at which cells you wanted totaled. If it is correct, 
just press <enter>. If not, click and drag over the cells you want included in the total. (B2:B6). 
You will normally want to include the blank cell so that if you ever insert a row between this 
range, the formula will automatically adjust to include the new entry. 

 

4. The formula should be as follows: SUM(D4:D11). The word SUM is an example of a function. 
This particular function adds the cells specified in the brackets. The part in brackets indicates 
this is a range of cells. 

5. Autofill this formula over to add up the other columns (GST and Total). 

 
 

To quickly see your formulas, try CTRL ~ (also referred to as CTRL TILDE). This 
command will show your formulas so you can troubleshoot your spreadsheet or 
keep an eye on your formulas to make sure they are working the way you want 

them to! Press it again to hide your formulas when you’re done. 
 

(The ~ key is on the top left corner of your keyboard, next to the 1 key.) 
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Practice: 
 
On the Practice tab at the bottom, create formulas to calculate the annual cost of each magazine as 
well as the GST and total. 
 
Do an AUTOSUM for the number of issues and autofill it for all of the columns  
 
Enter a formula to calculate how many magazines you would have to read per day, week and year. The 
results are below. 
 

Format the cells as either Accounting ( ) or Comma ( ). Adjust the numbers if necessary  
 

 
 
The Formulas: 
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Autofill 
 
To copy a formula or a value to the next cell or range of cells you can use the Autofill feature. This 
feature only works for cells that are adjacent to the cells you wish to copy. Excel will evaluate whatever 
you have selected and intelligently fill in the cells. 

You can quickly fill cells with several types of data based on adjacent cells.  When you click in a cell, 

notice that the lower-right corner is a black square.    This is called the fill handle.   

When you point to the fill handle the mouse pointer changes to a black cross.  + 

Click and drag the black cross to an adjacent cell to fill in the adjacent cell.   
 
Text and numbers are copied to the adjacent cells.  The cell references in formulas are adjusted to 
reflect the new cell location. 
 
Examples: 
 

If I type the following and Autofill across 
some cells: 

I will get: 

Jan Feb, Mar, etc 

January February, March, etc 

Mon Tue, Wed, Thu, etc 

Monday Tuesday, Wednesday, Thursday, etc 

Quarter 1 Quarter 2, Quarter 3, Quarter 4, Quarter 1, etc 

Store 1 * Store 2, Store 3, Store 4, etc 

1st District* 2nd District, 3rd District, 4th District, etc 

Elephant Elephant, Elephant, Elephant 

1000 1000, 1000, 1000 

1/1/2008 1/2/2008, 1/3/2008, 1/4/2008, etc 

 
*note: can be any word 
 
This will overwrite whatever was in those cells so be careful when doing this! 
 

Autofill Options 

The Auto Fill Options  button appears just below your filled selection after you fill text or data in a 
worksheet.  When you click the button, a list appears to give you options for how to fill the text or 
data.  

The available options depend on the content you are filling and the format of the text or data you are 
filling. 
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You will see a number of Autofill Options when you click on the box at the end of an Autofill action.  
 
One of the AutoFill options may be to ‘Fill Series.’ By choosing this option, you will continue a series 
based on a pattern.  For example, if you ‘Fill Series’ from a cell that contains the number 1, the next 
filled cell will be 2, the next 3, and so on for the number of cells filled.  This forms a series in the filled 
cells where each subsequent number is the previous number plus 1. 

1. Type 1 into a cell. 

2. Autofill it to a few adjacent cells. 

 

3. Use the Autofill options to specify it to Fill Series. It will increment each number by 1! 

 
In the next example, we will do the opposite -stop it from incrementing. 

4. Type Jan into a cell and press Enter. 

5. Click on that cell. Place the mouse pointer on the black box on the lower right comer of the cell 
(Autofill)  

6. When it changes to a black cross, click and drag it across or down a few cells. Watch the 
navigator as you are dragging. 
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7. If you had wanted it to simply fill the cells with Jan, then you would use the Smart Tag Autofill 
Options to specify “Copy Cells” to override the default (Fill Series). 

 

 

8. Try it with a date and you will see even more options! 

 

Autofilling a Pattern 

 
If Autofill doesn’t give you the pattern you’re 
looking for, you can create a pattern.  

1. Type the first two entries in, for example if 
you want to increase each number by 6 
starting at 3. 

2. Then type 3 in one cell, then 9 in the next 
cell.  

3. Next, select those two cells, let go of the 
mouse and autofill the selected cells to the cells you want the new numbers to go into. 

Autofilling Formulas 

 
When autofilling a formula, 
Excel automatically adjusts the 
formula. 
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Editing Cells 
 
Changing information in existing cells can be done in one of three ways: 
 

1. If you are entering data in a cell, and have not yet pressed the <Enter> key, then <Backspace> 
over the incorrect keystrokes. 

 

2. Retype the cell information. This method is used to edit cells with very few characters 
i.e. numbers (12334). It will overwrite anything already entered into that cell. 

 

3. Go into <Edit> mode. 

 

• Double click on the cell and make the changes to the cell - OR  

• Click on the cell you want to edit and then click on the formula bar - OR  

• Press <F2> and make the changes to the cell.  

 

• This can be extremely useful for cells containing long labels or numbers, or complicated 
formulas. Type the new information and press Enter. The previous contents of the cell will 
be replaced. 

 

• While in an edit mode, either the mouse or keyboard can be used for cursor movement. 

  

Click here 

Then, click here to type 
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Formatting Cells 

Formatting Numeric Cells 
 
There are a few buttons on the ribbon that make formatting a breeze. You never 
need to worry about typing a dollar sign, a comma or zeros after your decimal 
place. 
 
For example, you could just type 10 into a cell and have it appear as $10.00.  
 

 
Accounting Style - Formats selected text to display with a dollar sign and two decimals 

 
Percent Style - Formats selected cells to display percent with no decimal places 

 
Comma Style - Formats selected cells to display commas in large numbers as well as 
two decimal places 

 
Increase Decimal - Increases the number of decimals displayed after the decimal point 

 
Decrease Decimal - Decreases the number of decimals displayed after the decimal point 

 

1. Select a cell with a number in it. 

2. Click on the button with the Dollar sign on it.  
See how it adds two decimal places and a dollar sign.  
If it’s 1,000 or higher, it will add a comma. 
If it contains a zero, it will show up as a dash.  

3. Click on the Comma button. It looks the same but loses the dollar sign. 

4. If you do not desire that many decimal places, you can use the Increase Decimal or Decrease 
Decimal buttons to get the result that you want. 

If you would like to get the number back to the way it was typed 
in, click on the Number Format drop down box and choose 

General. It may display Text, Custom, Accounting, etc. 
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Formatting Date Cells 
 
As long as you enter a valid date into a cell so that Excel recognizes it to be a date, you can have it 
display any way you like. You can tell how your computer is set up by typing in a date that is only valid 
one way, for example Christmas. Only one of the following is valid: 12/25 or 25/12.  
 
If the computer is set up for month/day/year, then 12/25 will display as 25-Dec. Otherwise, it will show 
up as 25/12 and will not be recognizable as a date to Excel. 
 
If you do this test and decide you don’t like the way your computer is configured, you can go in to the 
Control Panel of Windows and choose Regional and Language settings (this might be worded 
differently depending on which version of Windows you have) and make the change there. 
 
Once you’re familiar with the format of how you can enter the date in, then you can change how it is 
displayed. For these examples, we will assume the computer is set to month/day/year. 
 
For example, if I type in 12/25/03, I can have it display any of the following ways, just to list a few: 

• December 25, 2003  
• Dec 25, 2003 
• 12/25/03 
• 25/12/03 
• 25-Dec-2003 
• 25-Dec-03 

1. Select the cells containing the dates. 
 

2. You can choose from the formats listed in the 
Number Format box on the toolbar or bring 
up the Format Cells dialogue box by clicking 
on the dialogue box launcher on the Home 
tab. 

3. Click on the Date Category on the left. It will display some types for you to choose from on the 
right side. If you click on one, you will see a sample of it at the top of the box. 
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4. If it doesn’t list the format you want, click on the Custom category on the left and you can type 
in your own format using placeholders.  

 
The following table lists some examples. 

 

Format Result 

m/d/yy 1/1/03 
9/15/03 

mm/dd/yy  
(extra zeros are added if necessary) 

01/01/03 
09/15/03 
12/01/03 
12/25/03 

mm/d/yy 02/1/03 
12/25/03 

dd-mmm-yyyy 24-Dec-2003 
01-Jul-2003 

mmm d/yy Dec 1/03 
Dec 25/03 

mmm dd, yyyy Dec 01, 2003 
Dec 25, 2003 

ddd, mmm dd, yyyy Sun, Apr 04, 2010 
Thu, Dec 25, 2003 

dddd, mmmm d, yyyy Sunday, April 4, 2010 
Thursday, December 25, 2003 

 

Try right clicking on a range of cells to see some great options!  
One is Format Cells which will also bring this dialogue box up! 
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Working with Columns and Rows 
 
Column Widths and Row Heights 
 
There are a few different ways to change your column width. 

Autofit 
 
Position your mouse pointer between two columns.  
 
Double click when you see the double headed arrow. This makes the column on the left of your mouse 
pointer as big or small as it needs to be to accommodate all the information in it. 
 
To change several columns, select the columns first, and then do the autofit on the last one of the 
selected columns. 

Manually Size 
 
With the same arrow, click and drag to manually size a column. To make several columns the same 
size, select the columns, then drag the last column and they will all be 
that same size. 

Specify a Width 
 
If you know the width that would like to make the column(s), select the 
column(s) and choose Format, Column Width from the Home tab. Type 
in a number for the selected columns.  
 
Hiding a Column 
 
Sometimes it is necessary to hide a column. With the same arrow as 
discussed above, click and drag it to the left until it is size 0.0. You can also right click and choose Hide. 
 
Unhiding a Column 
 
To unhide a column, take your mouse pointer to the line where the column should be and watch for it 
to become the same type of arrow you use to size and hide columns except that it will have a white 
line in the middle of it. Click and drag to the right when you see it and it will make the column visible 

again.  
 
Row Height 

Basically all of the above information is the same 
procedure as with rows. If you move your mouse 
pointer to the line between two rows and click and 
drag, it will change the size of the above row. 
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Inserting and Deleting 
 
To insert a row or column, select the row or column you want to move down or over to the right. If you 
want to insert more than one, select the number of columns or rows you want to insert first.  
 
If there is a blank row before a total row, select the blank row and choose Insert. This should adjust the 
SUM formula so that it includes the new row. 
 

 

1. Select a row or column. 

2. On the Home ribbon tab, click on the Insert or Delete button. This will insert 
additional rows or columns or delete selected ones. 

 
If you don’t have a column or row selected, just a cell, it will delete just the cell you are on and may ask 
if you should shift the cells below it up or the cells to the right of it over.  
 
 

Try right clicking on a range of cells and the Insert or 
Delete command comes up. Whichever option you 
choose will apply to whatever you have selected.  
 

 
 
ie. Select a row, then Insert, it will give you a new row. If you had a 
column selected, it will insert a column.  
 
If you just have one cell selected, it will insert a cell and push all the 
other cells down. Be careful with that! 
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EXERCISE 
 

LOAN CALCULATOR.XLS. 

1. Format the appropriate cells to look like the following: 

 

 
 

2. Type the date into cell C1 in the following format: m/d/yy. For example 3/17/08. Format it to a 
date format you like. For example, have it appear Mar 17, 2008. Try typing another date 
overtop.  
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Saving a Worksheet 
 
Saving your work is one of the most important tasks you perform. Saving a worksheet file copies 
worksheet data from computer memory to a file on disk. If you do not save a worksheet file, the data is 
lost when you close the file or end Excel. It is a good idea to save the worksheet file often during the 
work session. 
 
There are three ways to save new worksheets. 

1. Save  (on your toolbar or in the File menu)- opens the Save As dialog box and allows the user to 
type in a name. (A default name appears in the text box but can be overwritten by typing in a 
new name.) On a previously named file it will overwrite the file with the new information. 

Excel automatically puts on the extension XLSX. 

2. This can also be done by pressing <Ctrl S>. 

3. Choose Save As from the File menu button- does the same as Save on a brand new worksheet 
but creates a new file on a file that already has a name. 

 

Note…if you open an old spreadsheet saved in the previous 
version, it will automatically save back to that same 

version/format. 
 

If you create a new spreadsheet, it may be set to save in the new 
Excel format. This may cause problems if you are sharing 

spreadsheets with users who do not have this version (ie. clients, 
vendors, etc) as they may not be able to open them. You can use 
the Save As option to see the list of choices you have. Excel 2003 

is readable by anyone with Excel but if you are using any new 
features of Excel they will be lost. 

 
 
 
 

 
You may be interested in saving your spreadsheet as a PDF. This will allow anybody with or without 
Excel to view it. Typically, they will not be able to make changes to it. Look in the Save as Type box in 
the Save As screen to choose this file format. 
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Formula Exercises 
 

Open EXERCISES – EXCEL BASICS.XLS 

1. There are multiple exercises to do, each one in a different sheet at the bottom. You will see the 
instructions within the sheet.  

 

2. After you have followed all of the instructions, you may click on the completed version of the 
exercises to compare your answers. 

Additional Practice on Your Own: 

1. Create a budget for yourself! It could look something like this. Be sure to put formulas in to do 
the calculations. 

 

2. Use Excel to track RSVPs the next time you plan event whether it be work related or personal. It 
could be a birthday celebration, dinner party, staff luncheon, a course you’re organizing, etc. 

3. Create a spreadsheet to track your user IDs and passwords. Make sure to password protect this 
spreadsheet! 

4. Create a spreadsheet using one of the templates (File New) such as a calendar. 

5. Create a spreadsheet for a trip you are planning on taking or have already taken. Include the 
cost of transportation, accommodation, meals and entertainment. Calculate what the total cost 
will be for the trip. Add an extra night to see how it affects the total. Upgrade your hotel room. 
Insert a row for travel insurance and see your Total Cost increase. 
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Relative vs Absolute References 
 
Relative References 

Open GOLF TOURNEY LIST.XLS 

1. Enter the formula to calculate the Total # of Guest in E5. (=C5+D5) 

2. Autoflll the formulas down to the other guests. Notice that all the formulas changed. (ie. 
C6+D6, C7+D7, etc) 

This is called a Relative Reference. 
Absolute References 
Sometimes you don’t want the cell reference to change when it’s copied. You need to make it 
“absolute” before it’s copied so that it remains constant. 
 

 
 
In this example, we are using cell B17 to hold the price of the adult’s meal rate. In the formula in cell 
F5, we will reference the cell name containing the price, instead of the actual number ($20.00). This 
makes it easy to update if you think the price will change at a later date – all you would have to do is 
update one cell (B17), rather than all the formulas if you had typed the number into the formula. 
 
To make a cell reference absolute, press the F4 key after you’ve 
typed the cell reference. For example, to type the formula in cell 
F5 in the above exercise, type: 

1. =C5*B17 and press the F4 key. Press Enter.  

2. Autofill it down. 

 
You will see dollar signs go around the B17 reference. Now when you copy that formula down to the 
next cell, the C5 will change to C6, but the B17 will not change because you have made it absolute.  

=C5*$B$17 

will keep B17 constant 

but will change C5 to C6 

when copied down 
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Common Functions 
 
Excel functions are built-in formulas that perform specialized calculations automatically.  
 
Common functions are: 
 

Function Explanation Syntax Example 

=SUM Totals a range =SUM(RANGE) =SUM(C5:C10) 

=AVERAGE Averages a range =AVERAGE(RANGE) =AVERAGE(C5:C10) 

=MIN Lowest value in a range =MIN(RANGE) =MIN(C5:C10) 

=MAX Highest value in a range =MAX(RANGE) =MAX(C5:C10) 

=COUNT The number of values in a range 
(must be numbers present in the range in 
order to be counted) 

=COUNT(RANGE) =COUNT(C5:C10) 

=COUNTA The number of values in a range 
(if there is anything typed into the range, 
it will be counted) 

=COUNTA(RANGE) =COUNTA(B5:B10) 

 
AVERAGE, MAXIMUM, MINIMUM, COUNT 
 
The Autosum button has a drop down arrow that will allow you to choose the most common functions 
as listed above. If you want other functions not listed there, you will use the Paste Function tool.  
 

1. Click where you want the function to go (C15). In this example, we’ll 
create an Average. 

2. Click on the drop down arrow beside the Autosum tool  

3. Choose the function you want to determine. 

4. Next, it allows you to specify the range of cells to 
evaluate. You can either click and drag over the cells or 
type them in. When you are finished, press the Enter key. 

 



 Excel Level 1 and Beyond the Basics 

www.knowitsooner.com Page 23 © Know it Sooner Computer Training 

 
If you are doing a COUNT on non-numbers, ie. Names, you will have to add the “A” to the count to 
change it from COUNT to COUNTA. Follow the same steps as COUNT, just add the “A” right before you 
press Enter 
 

 

 
 

NOTE: When you are specifying a range to include, make sure you 
include any blank cells that may be filled in at some point. The 

blank cell is where you would go to insert a new row, should you 
wish to add data. If the blank cell is included in your formula, your 

formula adjusts automatically to include the new row! 
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Completed (after clearing cells C10:C11): 
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Exercise 

Open ABSOLUTE AND FUNCTION PRACTICE.XLSX 

1. There are several exercises to do, each one in a different sheet at the bottom. You will see the 
instructions within the sheet.  
 
The cells that required formulas are colored yellow. 
 

2. After you have followed all of the instructions, you may click on the Completed version of the 
exercises to compare your answers. 

 
 

Use CTRL ~ to check out your formulas!  
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Sorting your Spreadsheet 

 
You can display database records in any order by sorting or rearranging the data. You sort information 
in a database according to the contents of a column or group of columns, called a sort key.  You can 
also rearrange the order of columns in your database. 
 
It’s important that the spreadsheet is set up 
properly in order to sort. 
 

1. No blank row between the heading row and 
the first row of data 

2. There should only be one row of headings 

3. No blank rows or columns within your data 

4. There should be at least one blank row 
between your last row of data and your total 
row 

 
Simple Sorting 
 
It is very simple to sort by one column.  
 

1. Simply click on one of the cells in the column you wish to sort by (ie. Last name)  

2. Click on one of the sorting buttons, depending on if you want to sort by 
ascending or descending order.  

 

Press CTRL A to test that your data is set up currently. This will 
select the area that it will assume you want to sort. 

 
NOTE: It is very important not to select any data and then hit the sort buttons, because it will only sort 
what you have selected and leave everything else as is!! 
 
If you want to do any more complex sorting, simply click in your data somewhere and choose Sort from 
Custom Sort from the Sort & Filter button. 
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Printing 

 
This module will teach you how to print from a worksheet file and how to preview your worksheet file 
before you print it. You will also change the Page Setup including options such as Headers & Footers, 
Margins, Orientation and Scaling. 
 
Previewing Your Print Job 
 
It is a good idea to preview the print job before actually printing it as it saves time, paper, and 
toner/ink. The preview you will show you exactly how your data will appear on the printed page. 

1. Choose Print from the File menu. 

 

 
 
Many of the above features are on this screen, as well as a quick link to Page Setup. You are also able 
to perform other tasks right from this screen such as switch from portrait to landscape and choose a 
paper size. In the bottom right corner, you’ll see a couple of buttons for showing your margins and 
Zooming in and out. To get out of this screen without printing, simply click on the HOME tab at the top 
on the ribbon. 
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Page Setup 
 
The Setup command lets you adjust page margins, include a header or footer for each page, and 
specify other print and layout settings. 
 

1. Click on the Page Layout Tab on the ribbon or click on the Setup button if you’re in Print 
Preview.  

 
There are four tabs in the Page Setup box. Following is a list of the options which can be 
changed in Page Setup. 
 
 
 
 

In new versions of Excel, on the Page Layout tab on the ribbon, you can do 
many of these things without going into the Page Setup screen. For example, 
you will see an Orientation button. If you want to go into the Page Setup 
screen, simply click on the arrow (dialogue box launcher) at the bottom of the 
Page Setup group when you click on the Page Layout tab on the ribbon. 

 

 
 
 Dialogue Box Launcher 
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Page Tab 

 

 
 

Orientation  Determines whether Excel prints in portrait (vertical) or landscape 
(horizontal) mode. Landscape is not available for all printers. 

Scaling   Allows you to size the spreadsheet to fit onto the page. 

Paper Size  Allows you to choose the size of paper to print the spreadsheet on. 

Print Quality  Allows you to pick the quality of printing. 

First Page 
Number 

 Allows you to type a number for the page numbering to start at. 
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Margins Tab 

 
Top, Bottom, Left, Right  Specify the Left, Right, Top, Bottom Margins. 

Header, Footer Specify how close to the edge of the page to print the header and footer. 

Center on Page Lets you center the spreadsheet on the page either horizontally or 
vertically or both. 

 
NOTE: You can also modify your margins while you’re in Print Preview, you don’t 
even need to be in the Page Setup box. Just click on the Show Margins button on 
the bottom right corner of the screen and you will be able to move the margins 
around yourself rather than typing in a dimension. 
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Header/Footer Tab 

 
 

Header Constant text at the top of the page. i.e. Text, Page #. 
 You can pick a predefined header or create a custom one. 

Footer Constant text at the bottom of the page. i.e. Text, Page #. 
 You can pick a predefined footer or create a custom one. 

 
 

Adding a Page Number 

1. If you would like a page number to appear on every page, click on the Custom Header or Footer 
button. 

2. Position your cursor to where you want it displayed. 

3. Type the word Page, if desired, and then click on the Page 
Number button. 
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When creating a custom header or footer, you can insert special codes that will update every time it is 
printed. These special codes can be typed into the Custom Header or Footer or you can click on the 
tools that appear in the Header or Footer screen. If you click on the ‘Custom Header’ or ‘Custom 
Footer’, you will display the following dialog box: 
 

 
 

  Displays the Font dialog box so you can adjust the font, size, and 
style of the text for each of the three sections of the header or 
footer 

 &[Page] Inserts the page number 

 &[Pages] Inserts the total number of pages 

 &[Date] Inserts the date 

 &[Time] Inserts the time 

 &[File] Inserts the filename of the workbook 

 &[Tab] Inserts the name of the current worksheet 

 &[Path]&[File] Inserts the path and filename (ie. c:\data\budget.xls) 

 &[Picture] Displays the Insert Picture dialog box so you can insert a picture 

   Displays the Format Picture dialog box so you can adjust picture 
properties 

 
  

FONT 

PAGE NUMBER 

TOTAL PAGES 

DATE TIME PATH & FILE 
NAME 

FILE NAME 

SHEET NAME 

INSERT PICTURE 

FORMAT PICTURE 
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NOTE: You can also edit your headers and footers through 
the Page Layout View Tab on the bottom right corner of 
your screen. 
 

 

 
 

 
 
 

This allows you to click where you want to type in your header/footer and add useful 
codes to it such as page numbers and/or dates. 

 
To get your screen back to normal, click on a cell within your spreadsheet and then click 
on the Normal View button. 

 
 

 
 
  

Normal 
View 

Page 
Layout  

Page Break 
Preview 
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Sheet Tab 

 

Print Area Allows you to define an area on the spreadsheet to print 

Print Titles Specifies the columns of worksheet data to print at the left of 
every page and print range and the rows of worksheet data to 
print at the top of every page and above every print range. 

Print options Allows you to choose to print gridlines, row and column 
headings and other options. 

Page Order Allows you to choose which order to print the pages if they 
happen to span across more than one page. 

Other Options Gridlines, Row and Column Headings, how to print comments 
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Printing the Worksheet 
 
If you chose a print area in Page Setup, you can select 
Selected Sheet to print the range. If you didn't set a 
print range, Excel guesses at what to print. If you 
select a range before going into the Print menu, you 
can choose Selection. This overrides the specified print 
area. You also have the option to print all the sheets 
by choosing the Entire Workbook. 
 
You can also choose how many copies to print and 
which pages. 

1. Choose Print from the File menu. 

Print Areas 
 
You may choose to set up an area to print each time you print this spreadsheet or you may set up a 
one-time print area. 

1. Temporary Print Area 

To print only a portion of the spreadsheet, simply select the area, and choose SELECTION from 
the Print menu under Settings. It likely displays Print Active Sheets as a default. 

2. Permanent Print Area 

Method One: 
To choose an area to print, click on the 
SHEET tab from the File Page Setup menu. 
{Click} in the Print Area box and click and 
drag over the cells you want to print. You can 
also type the names of the cells in. When you 
choose Print from the file menu or the toolbar, 
this area will always print. 
 
Note: You must go into Page Setup from the 
Page Layout tab. You cannot access it from the 
Print screen to modify Print Area and Print 
Titles. 
 
Method Two: 
Choose Page Break Preview from the bottom 
right of your screen or from the View ribbon 
tab. Drag the blue lines around the cells you 
wish to print. 
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Print Titles 
 
You can set your print titles if you have a long and/or wide spreadsheet and you need certain 
information repeated on every page. An example you be if you need to produce a list of people. Maybe 
you want a list of their names and phone numbers. But it would also be great to have a list that has 
names and maybe a membership number. Or maybe a sign in sheet for your regular meetings.  
 
If you have that many columns of information, how will you ever all fit it on one page? You can flip 
your spreadsheet to print landscape and decrease your font size, but it would be really great if you 
could just select the columns you want to print and not worry about the other ones. 
 
This is easily done with a few simple steps.  

1. Start by typing all your information in, starting at column A. Make sure you separate first name 
from last name, this allows more flexibility later should you decide to merge a letter to your list 
of names. 

 

2. Click on the Page Layout tab and then Print 
Titles. This takes you directly to the Sheet 
tab within the Page Setup box. 

Here you will set up the rows and columns 
to print on every page. Later, you will select 
only the data you want to print and these corresponding rows and columns you choose on this 
screen will automatically print. 

3. Click in the “Rows to Repeat at Top” text area. 
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4. Next, click anywhere on the row that contains your heading row. This step is something you 
should do in all Excel spreadsheets in order to have this row repeat at the top of every page. 
You will see that the row number, along with some dollar signs appear. Don’t let the dollar signs 
scare you, just ignore them!  

 

5. Now you will do the same with the columns. Click on the “Columns to Repeat at Left” text area 
and then click in your spreadsheet where the columns you wish to always appear are. In our 
case, it is column A and B. This is the secret to making great reports in Excel! 

 

 

6. After you’ve clicked OK to save your changes, the rest is very simple. Simply select the cells you 
want printed, excluding the rows and columns you chose in the above steps. For example, if you 
want a list of names and phone numbers, simply drag your mouse over all the phone numbers. 
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7. Now you’re ready to print. Go into the File menu and choose Print. The trick here is to click on 
the Selection option to make it only print your print titles which you set up earlier and the 
selected cells. You may want to click on Preview the first time, just to make sure everything 
looks good before you actually print. 

 

 
 

There you have it! Only the selected information prints with the print titles! Remember when 
setting up your spreadsheet, put like columns together so that you can print multiple columns 
this way. (For. an address list, you would select the address fields, plus city, province/state and 
postal/zip code) 

 
Next time, you can select something different, say Company and title and repeat the above 
step. Another great list! 
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Exercise 

Open BUDGET.XLS 

1. Sort the list alphabetically by the expense name.  

2. Then sort the list to make the highest expense at the top. 

3. Do a Print Preview (File, Print) to see how the spreadsheet would look like if it printed now. 
Notice how it is two pages and only January to June fits on page one. Page two shows the rest 
of the year. 

4. Change the format to LANDSCAPE. (Page Layout ribbon tab or Page Setup, Page tab). 

5. Print Preview to see the change.  

6. Set the print area to A1:N30. (Page Layout ribbon tab, click Print Titles, and click on the Sheet 
Tab) This will make only the expenses print, not the income and profit lines. 

7. Print Preview the sheet. 

8. Make it fit on one page with the Fit to Page 
(scaling) feature. (Page Setup, Page Tab, click the 
circle beside Fit to 1 page wide by 1 page tall) 

9. Add the following Header in the center: Budget 
Projections. (Page Setup, Header/Footer Tab, then 
Custom Header) 

10. Add the date on the bottom left. (Page Setup, 
Header/Footer Tab, then Custom Footer) 

11. Remove the gridlines. (Page Setup, Sheet tab) 

12. Print preview the sheet. 

13. Set your print titles. (Page Setup, Sheet tab,  
Rows to Repeat at top – row 6 
Columns to Repeat at Left – Column A 

14. Do a Print Preview of just your total column (N) and 
your expenses. (Select Column N, Office/File menu, 
Print, choose Selection, then click Preview) 
 
For Example, see the sample to the right. 
 
Note: It may not be sorted in the same order as yours. 

Exercise #2 – Open BUDGET PRINTING.XLS and following the instructions.  



 Excel Level 1 and Beyond the Basics 

www.knowitsooner.com Page 40 © Know it Sooner Computer Training 

Excel Level 2 (Beyond the Basics Day 1) 
 

Intermediate Functions 
 

In this module, you are introduced to some intermediate functions that can be helpful when working 
with Excel. These include the IF statement, and the VLOOKUP, ROUND, NOW and COUNT functions. 
 
The =IF Statement 

Open OFFICE SUPPLY SALES.XLS 

 
The =IF statement is used when the user wishes to assign a value, perform a calculation or display a 
message based on the result of a condition. Here are some IF statements for this example. 
 

• First, in column H, we want to display a message indicating if it is a large sale or not. There is 
an amount typed in cell M3 that shows the value we have determined is a large sale 
amount. 
 

• In column I, we will give them a different commission depending on if the total is greater 
than or equal to the Large Order Size. (Commission percent multiplied by the Total). 
 

• In Column J, we will use the Large Order size to determine if they get a bonus or not. 
 

 

 
  



 Excel Level 1 and Beyond the Basics 

www.knowitsooner.com Page 41 © Know it Sooner Computer Training 

 

1. {Click} on cell H4. 
 

2. {Click} on  

 
 

3. {Click} on IF in the Function Name box. If IF is not displayed, choose the ALL Category. 

 

4. Click OK. 

 
When we use the IF statement, it 
asks first for the condition, then 
the action to perform if it is true 
and then if it is false. 
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You then need to give it the test. You can compare 2 cells together, or a cell and a number as we are 
doing in this example. You use the following operators to do the comparison: 
 

= Equal to < > Not Equal to 

> Greater than >= Greater than or Equal to 

< Less than <= Less than or Equal to 

 

5. In the logical_test box, click on G4 and type >=M3. You will then need to hit F4 so this cell 
reference is absolute when it is copied down. 
This will determine if the total is a large sale or not. 

6. Click on the next box or press TAB to get there.  

7. In the value_if_true box, type Large Order!. 
This will display Large Order if the total is larger than the amount that is typed in cell M3. 

8. In the value_if_false box, type Small Order. 
This will display Small Order if the total is less than the amount that is typed in cell M3. 

9. Press the FINISH or OK button. 
The formula =IF([@Total]>=$M$3,"Big Order!","Small Order") appears in the formula bar. 
 

 

 

10. Copy the formula using Autofill to display messages for the rest of the employees. Note the 
results. 
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Completed spreadsheet is as follows.  
 
 

 
 
 
Here are the formulas: 
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Exercise #1 

1. Open IF-Exercises. 

2. Starting on the first sheet, use the instructions on the sheet to fill in the formulas.  

3. Check your answers on the completed version. 

4. Make sure you follow all of the instructions if you are comparing the answers! 
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Conditional Formatting 
Conditional formatting allows you to set rules for cell formatting. If the rules (conditions) are met, then 
the formatting is applied.  
 

Open CLASS MARKS - CONDITIONAL FORMATTING 

Highlighting Cells 
For example, you can set conditional formatting so that a cell turns color if it contains a value higher 
than 75.  

1. Select the cells to be formatted. 

2. Click on the Conditional Formatting button on the Ribbon (Home tab). 

3. Choose Highlight Cell Rules, then Greater Than. 

4. In the text box, type a number or a cell reference. In this example, type the value you want to 
check -- 75. 

 

5. Click on the Drop Down box to pick a format. 

6. Click OK. 
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There are many other options to experiment with as well, such as Top 10, Data Bars and Icon Sets. 
 

Top/Bottom 
 

 
 

Data Bars: 
 

 
 

Color Scales 
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Icon Sets 

 
 

Modifying the Conditional Formatting 

1. If you need to do any modifications to the conditional formatting, such as specify how the icons 
are assigned, first apply the conditional format. 

2. While the cells are still selected, go into the Conditional Formatting menu and choose Manage 
Rules. 

3. Then choose Edit Rule. Make sure your rule is selected. 

 
 

4. Make the appropriate changes. In this example, we are changing 
the icon designation. We want a check mark if the mark is 80 or 
higher, the exclamation mark if it’s between 50 and 80 and the X 
if it’s below 50. 
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Named ranges 
 
By naming a range, you are providing a convenient and efficient way to refer to the range in commands 
and formulas. You can assign a name to any range in the worksheet. Once the range is named, the 
name can be used any time you need to refer to the range. 
 
You can give the same range several different names if you plan to use the data in different places and 
a cell address can belong to several range names. 
 
Advantages to using named ranges are: 
 

• Easier to type and is more user friendly (i.e. it is easier to type OT_RATE in a formula than $B$13) 

• Lessens the chance that incorrect cell addresses will be used 

• Eliminates the need to continually type in the coordinates for ranges you use a lot 

 
GUIDELINES TO FOLLOW WHEN NAMING RANGES: 

• Use a name that is relevant to what the name contains. 

• The range name can be up to 256 characters. 

• The name cannot contain space. Use underscores to make the name more readable. (ie. Jan_Sales) 

• Range names are not case sensitive. 

• The range name should not contain actual cell references. 

• If you delete a range name, check and make sure all values and formulas are correct. 

• If columns/rows are inserted, check the range for references. 

• Cell addresses can be used in more than one range. 

• Range names can be used in any option requiring a range (i.e. print area). 

• Range names are stored with the worksheet when saved. 

 
WHAT CAN YOU DO WITH A NAMED RANGE? 

• Print it (Print Selection) 

• Use it in a formula (Just type the name instead of the cell names) 

• Copy it and paste it somewhere else 

• Delete the data 

• Create a graph with the data 

• Total it (just click on the AutoSum tool) 
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Open INVEST-NAME EXERCISE.XLS 

 

Naming the Range 

There are 2 ways to name a range: 

• Manually (you decide what to call it). 
• Automatically (the names are already contained in the worksheet). 

Manually naming a range of cells 
In this example, we will name the cells that contain investor information (cells A4:L65).  

1. Select cells A4:L65. 

2. Click to the right of the Name Box.  

3. Type in INVESTORS and press <ENTER>.  

This will assign the name Investors to the cells A4:L65).  

4. Press <CTRL HOME> to deselect the cells and return to cell A1. 

5. Click in the name box and you should see the INVESTORS range listed there. Click on it and you 
will see your whole range selected! 

Naming a Single Cell 

1. Click on cell D2. We will name this cell and later use it in a formula. 

2. Click on the arrow beside the name box and type in commrate. Press Enter. 

 
 

If you use the above method, the range will be visible from any sheet within the 
workbook. The downside of that is that if you had a similar range in another 
spreadsheet, you could not name it the same name. So if you create your range 
name using the Define Name button, on the Formula tab on the ribbon. 
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Automatically naming a range 
If you want to name more ranges and potential names are already 
in your spreadsheet, you can use the Create From Selection 
feature. In this example we will give names to each set of data 
(i.e. names, position, start date, etc). 

1. Select the INVESTORS range. 

2. Go into the FORMULAS ribbon tab and 
choose CREATE FROM SELECTION. You 
will be prompted to specify where the 
names exist, based on what you have 
selected.  

3. Ensure Top Row is the only choice 
selected. Click OK. 

4. Click in the name box and you will see 
one name for each column you had selected!  

Using the named range in a formula 
 
One of the most common applications for named ranges is to use them in a formula instead of typing 
the name of the cells. By doing this, the cell references are automatically absolute. 
 
In this example, we will determine the average age of the investors, by using the 
Average function and the named range, AGE. 

1. In cell B68, click on the drop down arrow beside the AUTOSUM button  

2. Choose Average and click on OK. 

3. Now instead of typing in the cell names of all the ages (L5:L65), just type 
AGE. Click on OK. 

 
If you ever need to reference your range names while you 
are in a formula, simply press the F3 key and they will be 
listed for you to pick the one to use in your formula! 

 

4. In cell D5, create a formula to figure out the commission. Use your newly named rate to 
multiply it by the investment amount to get the commission. 

5. Copy it down to the other rows to calculate commissions for each investor.  
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Exercise #1 

Open Golf Tourney List. 

1. Create two named ranges for the costs in B17 and B18. 

2. In cell F5, create a formula to calculate the price of the adult meal for the first person using the 
named range. (ie. if you named cell B17 “adultcost” then, the formula would be =C5*adultcost.  

3. Autofill the formula down. Notice how there is no need to make anything absolute! By using a 
named range, this is done automatically. 

4. Do the same for the formula in cell G5 to calculate the price of the children’s meal. 

5. Using the “Automatically Create Names” feature, give all the data names except the total.  

6. Go down to cell A20 and type in: The number of employees invited are 

7. Then in cell C20, use the COUNTA function in combination with your named ranges to count the 
number of people listed in column A.  
ie. =COUNTA(First_Name) 

 

Exercise #2 
 

Open Price list - named ranges 

 

1. Follow the instructions in the sheet to create and use named ranges. 

 

Exercise # 3 
 

Open Mileage sheet - named ranges  

1. Follow the instructions on the sheet. 
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Data Tables 
 
Named ranges are useful in many instances but data tables are even better if you will be adding data to 
the bottom of your list. If you make the range into a table, you will automatically expand the range and 
your data will be included. With named ranges, you always need to insert a row within the data in 
order to expand the range. 
 
Tables are discussed more in depth later in this manual and have many other benefits as well. 
 

Open Employee Shirts 

 

1. First test your data to be sure there are no blank rows or columns by clicking on one cell in your 
list and pressing CTRL A. 
 
This should select all the cells including the headers. 

2. Now choose Table from the Insert tab or press CTRL T. 

3. It will display a box listing what it recognizes as all the cells containing data, including the 
headers. Be sure that it recognizes that the first row contains header rows. 

 

4. Now your list is in a table. It has a name which you can change or leave as is. You may want to 
click on the Table Tools tab on the ribbon to see what the name is in order to use it in a formula 
similar to how a named range is used.  
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VLOOKUP 

Overview 
 
The =VLOOKUP function comes in handy whenever there is information to be pulled out of a table, 
either on the same sheet or in another one. 
 

Open BIRTHMONTHINFO.XLS 

 
The following is an example of 3 VLOOKUP functions. They have been entered into B12, B13 and B14. 
By typing in the month number in B3, the VLOOKUP looks it up and pulls back the appropriate 
information (ie. Full month name, birthstone, and flower). 
 

 
 
The information is pulled from a range of cells referred to as a Lookup table. We have stored this on 
another sheet. It is advisable to make it into a table (CTRL T), then click on the Table Tools tab and 
make note of the name. 
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1. Click on the  button and locate VLOOKUP either 
in the Most Recently Used category or in the ALL 
category. 

2. Click OK. 

3. The VLOOKUP function screen appears. It asks for 3 
mandatory pieces of information. The fourth is 
optional. Each are discussed below. 

4. In the lookup_value box, type or click on B3.  
 
 

 

This is the value you are using to look up the information with, which is the number of the 
month. It will look this number up in the table array and will choose the closest match, unless 
otherwise specified in the RANGE LOOKUP field. 
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5. In the table_array box, it is looking for the master list. Type the name of the table that this list is 
stored in. 

This is where the information is stored. Think of this 
like a master list where you will find the information 
you are looking for. It can be on the same sheet or 
on a different sheet. It is a good idea to make this 
data into a table. 

6. In the col_index_num box, type 2. 

This will return the value in the 2nd column in the 
table, which is the month number. 

7. In the range_lookup box, type FALSE. 

This box is used to specify if you want to find an 
exact match or an approximate match. Type FALSE if you expect it to find an exact match and if 
it doesn’t, it will give an error.  

8. Press Finish or OK. 
 

The formula: 
=VLOOKUP(B3,table1,2,FALSE) appears. 
 
Now if any information on the master 
list changes, it will automatically change 
on the other parts of the spreadsheet 
where you have referenced it. 

 
You would do this same formula to pull 
the other two pieces of information 
(birthstone and flower). The only 
difference would be that it pulls 
different column index numbers since this information appears in different columns.  

Exercise 
 

Open VLOOKUP EXERCISES.XLS 

 

1. Starting on the first sheet, use the instructions on the sheet to fill in the formulas.  

2. Check your answers on the completed version. 

3. Make sure you follow all of the instructions if you are comparing the answers! 

  

Rules for a lookup table: 
 

• It must be sorted by the first 
column, which must be unique 

• It can be on the same sheet, but it 
may be better if it’s on a different 
one, just for organizational 
purposes. 

• It is advisable to make this list into 
a data table.  
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XLOOKUP 
 
There’s a new function that came out with Microsoft 365 called XLOOKUP which is similar to VLOOKUP 
but is more flexible! 
 
The XLOOKUP function searches a range or an array, and then returns the item corresponding to the 
first match it finds. If no match exists, then XLOOKUP can return the closest (approximate) match. 
=XLOOKUP(lookup_value, lookup_array, return_array, [if_not_found], [match_mode], 
[search_mode]) 
 

Argument Description 

lookup_value 

Required* 

The value to search for 
 
*If omitted, XLOOKUP returns blank cells it finds in lookup_array.    

lookup_array 

Required 

The array or range to search 

return_array 

Required 

The array or range to return 

[if_not_found] 

Optional 

Where a valid match is not found, return the [if_not_found] text you supply. 

If a valid match is not found, and [if_not_found] is missing, #N/A is returned. 

[match_mode] 

Optional 

Specify the match type: 

0 - Exact match. If none found, return #N/A. This is the default. 

-1 - Exact match. If none found, return the next smaller item. 

1 - Exact match. If none found, return the next larger item. 

2 - A wildcard match where *, ?, and ~ have special meaning. 

[search_mode] 

Optional 

Specify the search mode to use: 

1 - Perform a search starting at the first item. This is the default. 

-1 - Perform a reverse search starting at the last item. 

2 - Perform a binary search that relies on lookup_array being sorted 
in ascending order. If not sorted, invalid results will be returned. 

-2 - Perform a binary search that relies on lookup_array being sorted 
in descending order. If not sorted, invalid results will be returned. 

 
  

https://support.microsoft.com/en-us/office/using-wildcard-characters-in-searches-ef94362e-9999-4350-ad74-4d2371110adb
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Why is XLOOKUP better than VLOOKUP? 

1. You can re-sort your lookup table and it won’t mess up the function 

2. The column you’re using to find the match in doesn’t have to be the first column in your table 

3. You can specify to start looking at the bottom if you’d like! 

4. You can choose if you want the next highest or lowest if it can’t match exact. 

  

• Find the month number  
(B6 which is 7) 

• In the Month Number Column 
in the table  
(presently column A) 

• Return the corresponding 
Month Name  
(presently column B) 

• The match mode is defaulted to 
forcing it to find an exact match 

Click here to find it 
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NOW 
 

Open ROUNDING EXERCISES.XLSX 

 
The NOW function is used to enter the current 
date into the spreadsheet. When you open the 
spreadsheet, it automatically fills in the current 
date. 
 

1. Click on cell B1. 

2. {Click} on  

3. Choose NOW from the Most Recently 
Used list or from the ALL category and 
click OK. 

4. Just click OK to get past the next screen. 

 
Very simple – it just adds: 
 
=NOW() to the formula and will give the current 
date.  
 
You can choose to format it the way you want to 
in the Format Cells dialog box. 
  



 Excel Level 1 and Beyond the Basics 

www.knowitsooner.com Page 59 © Know it Sooner Computer Training 

 
ROUND 
 
Many times you need to round a number to the nearest decimal place. 
The ROUND function allows you to specify the number of decimal places 
to round the number to. Other variations of ROUND are ROUNDUP and 
ROUNDDOWN (same as TRUNC). 
 
In this exercise, we will round the totals to have no decimals places. 
 

1. {Click} on cell H6. 

2. {Click} on  

3. Choose ROUND from the Most Recently Used list or from the ALL category. 

4. Click OK.  

5. For number type G6 or {click} on G6 with 
the mouse. 
 
This indicates which cell is to be rounded. 

6. For the num_of_digits type 0. 
This number indicates which decimal 
place to round to.  
 
If the number is positive, it rounds after 
the decimal place. If it is negative, it 
rounds before the decimal place (i.e. -1 
would round 77 up to 80). Experiment by 
typing different numbers into this field 
such as 1, 2 and -1. 
 

{Click} FINISH or OK. 
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Exercise 

Open ROUNDING EXERCISES.XLSX 

1. Starting on the first sheet, use the instructions on the sheet to fill in the formulas.  

2. Check your answers on the completed version. 

3. Make sure you follow all of the instructions if you are comparing the answers! 
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Working with Multiple Sheets 
 
Usually a new Excel workbook starts with one worksheet, but more can be added if required. They are 
numbered Sheet1, Sheet2, etc. The names appear at the bottom of the screen and are accessed simply 
by clicking on their tabs. 
 
In this example, we will manage a sales report for a stationery company. There are spreadsheets for 
the first three quarters of the year and a summary sheet. We will be creating a sheet for the fourth 
quarter and then link totals to the summary sheet. 
 

OPEN SALES-LINKING.XLS 

 

 
 
Navigating Through the Sheets 
 

• To move between sheets, click on the appropriate tab. If you can’t see the tab you want, use one 
of the arrows beside the tabs to scroll through the tabs 
of the sheets or click on the three little dots. 

• The arrows with the lines take you to the first and last sheet tabs. . You can 
also hold the CTRL key and click an arrow to take you to the first or last sheet. 

• The left and right arrows take you forward or backward through the tabs, one at a 

time. . 

• <Ctrl Page Up> and <Ctrl Page Down> moves you backwards and forwards 
through the sheets, one at a time. 

• Right Click on the arrows to see a list of all your sheets.   
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Move a Sheet 
You can easily move a sheet, just to change the order, as it might seem more logical. 
 

1. Simply click and drag the sheet tab at the bottom until the black pointer is pointing at the 
desired position.  

 
For practice, move one to the end, behind the Summary Sheet. Now move it back. 

Copy a Sheet 
 
The procedure for copying a sheet is identical to moving except by holding the CTRL key down as you 
drag, you are copying the sheet, not moving it.  
 
This method is much better than copying the information and then pasting it onto the next blank sheet 
as you normally want the worksheet formatting to be copied as well (i.e. Column widths, print areas, 
headers, footers, etc.). Copy and paste does not allow you to do this, however, copying the entire 
sheet does! 
 

1. Hold the <CTRL> key down and click and drag one of the sheets. Let go when the black pointer 
is behind one of the sheets. ALWAYS LET GO OF THE MOUSE FIRST!! 
 

 
Want to move or copy a sheet to a new workbook or an existing one? Right click 
on the sheet and choose Move or Copy. You will see your choices to move/copy 
to a new one or one that you already have open. 
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Rename a Sheet 
 
To make sheets easier and more practical to work with, you can rename them. 
 

• The name can have spaces. 
 

• Don’t use special characters such as:   , /, \, ? or *. 
 

1. {Click} on the new sheet tab with your right mouse button. 
 

2. Choose Rename with your shortcut menu. 
 
You can also {double-click} on the tab to bring up the Rename menu. 
 

3. Type in the name of the new sheet. 
 

4. Press <Enter>. 
 

 
Try double clicking on a sheet name to automatically pop you into “Rename Mode”! 
 
 

 
Delete a Sheet 
 

1. Right click on the sheet tab and choose Delete. Note that you cannot undo this command. 

 
Insert a Blank Sheet 
 
If you just want a new blank sheet, not a copy of an existing one, simply click on the Insert Worksheet 
button on the Worksheet bar at the bottom of your screen. 
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Grouping Sheets 
 
Sometimes you need to group sheets to print, create formulas, or change the formatting. Once the 
sheets are grouped, all changes you do will affect those sheets. You must be careful that if you type 
anything into a cell while you have them grouped, you may 
overwrite existing information that was already there. 

Selecting All Sheets to Group 

1. {Click} on the right mouse button on one of the tabs. 
 

2. Choose Select All Sheets. 

 
Notice the title bar indicates the sheets are grouped. 

 

 
 

Ungrouping Sheets 
 
To ungroup all the sheets so you are only modifying one of them: 

1. {Click} on the right mouse button. 

2. Choose Ungroup Sheets.  
 -OR-  
 {Click} on one of the sheet tabs.  

  



 Excel Level 1 and Beyond the Basics 

www.knowitsooner.com Page 65 © Know it Sooner Computer Training 

 

Selecting Specific Sheets 
 
To select specific sheets to group, rather than all the sheets, depends on whether or not the sheets are 
next to each other. 
 

If the Sheets are Adjacent to One Another (i.e. Sheet1, Sheet2, Sheet3): 
 

1. {Click} on the first sheet you want to group. 

2. Hold down the <Shift> key. 

3. {Click} on the last sheet you want to group. 
 
Notice the title bar displays a message that they are grouped. 

 

4. Ungroup them by clicking on one of the sheets NOT in the group. 

 

If the Sheets are not Adjacent to One Another (i.e. Sheet1, Sheet3, Sheet6): 
 

1. {Click} on the first one you want to group. 

2. Hold down the <Ctrl> key. 

3. {Click} on each of the sheets you want to group. 

 

4. Ungroup them by clicking on one of the sheets NOT in the group. 
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Exercise 
 

1. Group all of your sheets, select cell B2 and enter your name in there instead of John Doe’s. 
 

 

2. Ungroup the sheets.  
 

3. Group all the sheets except for the Summary Sheet. 
 

4. Select cells B5:D5 and then center them. 

 

5. Ungroup the sheets. 

6. Look at the other quarter sheets and you will see that the cells are also centered on these 
sheets too! 

 
 

 
This command is great for setting column widths after you’ve just entered a bunch of 
numbers! You may find your columns are too small so just select all or some of your 
sheets, and autofit them! They will all be changed! 
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Linking Cells from One Sheet to Another 
If you want one cell’s results to appear in another sheet, you can link the cells.  
 
In this example, we want to show how many of each product was sold per quarter on the summary 
sheet. 
QUARTER ONE SHEET: 
 

 
 
SUMMARY SHEET: 
 

 
 

1. Click on cell B6 in the Summary Sheet. 

2. Press = 

3. Click on the Quarter1 Sheet tab. 

4. Click on cell F6 and press Enter. 

5. Autofill it down for the other products. 
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Creating 3D Formulas 
 
It is easy to perform calculations across sheets. In this exercise, we will create a formula to go on our 
Summary sheet that adds up all of the commissions that were paid out.  
 
It is important to ensure that the commissions reside in the same cell if you are using the AutoSum 
feature to add them up! 
 
SUMMARY SHEET: 

  

    
 
Quarter 1 sheet Quarter 2 sheet Quarter 3 sheet Quarter 4 sheet 
 
1. {Click} on cell B14 on the Summary Sheet. This is where we want the total to go. 

 

2. {Click} on the AutoSum tool.  
 

3. {Click} on the first sheet (Quarter1). Notice how it adds the name of the sheet to the formula. 
 

4. Hold down the <Shift> key and {click} on the last sheet (Quarter4). 
The formula now lists these sheets as the range of sheets to use. 
 

5. {Click} on F14 and Press <Enter>. 
This adds F14 to the formula to indicate that this is the cell in all spreadsheets to add up. 
 
Your formula should now read =SUM('Quarter 1:Quarter 4'!F14)). 
 
Now if anything in the sheets change, the summary sheet will change too!  
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Exercise #1 

1. Open Registration List.xls. This spreadsheet 
is one that is used to administer four 
children’s groups. It also contains a 
summary sheet. 

2. On each of the first four sheets, there is a 
COUNTA function entered in cell B11 that 
calculates how many people are registered 
in each group. Link that cell on each sheet 
to the appropriate cell in the Summary 
sheet. 

3. Group all the sheets and add today’s date to cell B1. 

4. Ungroup the sheets. 

5. Make a copy of the Boys sheet and position it first, on the left hand side of 
the Messengers sheet. This will be your template in case there are new 
groups to add. 

6. Clear rows 4 to 10. Rename this sheet to Blank. 

7. Group the first five sheets (from Blank to Youth). 

8. Create an Autosum in cell I11 that totals up the fees paid. This should put the 
formula onto all of your sheets! Make sure the Autosum contains the correct 
cells! 

9. On the summary sheet in cell B12, do a 3D formula 
to add up all the amounts in cell I11 in the other 
sheets, including the blank one (for future use). 

 

10. Add one more person to one of the groups. Enter 
an amount for their fee. Go to the summary sheet 
and the new person’s numbers should be included! 

Exercise #2 

1. Open ACCOUNT ACTIVITY – SHEETS.XLSX 

2. Link the totals from the three yearly sheets to the appropriate place on the summary sheet. 

3. Do a 3D formula to calculate the Total sales as well as the average from the three sheets.  
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Formatting Shortcuts 
 
Excel offers many shortcuts to work with your spreadsheet quickly and efficiently. 

Wrapping Long Titles 
 

Open GOLF TOURNEY LIST2.XLS. 

 

 
 

Many times the column headings are longer than the numbers or text under them. Therefore, best 
fitting the column is not always the best way to size a column. We can use the wrap text feature to 
wrap the long title within the cell by making 
the cell higher. 

1. Select the headings (A4:H4).  

2. Click the Wrap text button on the 
toolbar of the Home tab. 

 
 
To choose other options, click on the 
Dialogue box launcher beside the Alignment 
options. 
 

If you prefer, you can force the cell to wrap as you type by pressing ALT ENTER in the 
cell where you want the line to break. You don’t even need the WRAP TEXT option! 
 
By typing:  
 
START <ALT-ENTER> DATE 
 
Would place START on the first line of the cell and DATE on the second line 
automatically.  
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The Format Painter 
 
The Format Painter tool offers a quick way to format a range of cells to look like another. 
 
In this exercise you will format the title (A1) and then apply the same format to the subtitle (A2).  
 

1. Select cell A4. 

2. Bold, Italicize and make the font larger. 

3. With cell A4 still selected, click the Format Painter tool.   

4. Drag over the other heading cells (B4:H4). 
 

The headings are all formatted the same way now! 
 

 
If you have several cells to apply this format to, instead of 

clicking once on the paintbrush, double click it and the 
Format Painter stays on so that you can select different 

cells and apply it.  
 

You must press ESC or click on the paintbrush again to get 
out of this mode. 

  

Merge and Center 

1. Select cells A1:H1. 

2. Click on the Merge Cells button  
The Merge & Center command merges the cells and centers the 
title across the spreadsheet. 

3. Try it on the title on the second row as well. 
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Graphs 
 
You can create great looking graphs and have them link to your data. If a number changes in your 
spreadsheet, the associated bar will change in your graph! 

 

Open EXPENSE BUDGET-GRAPHING.XLSX 

 
Start by selecting the data you want to graph. If the columns do not appear side by side, select the first 
range, then hold down the CTRL key and select the second range and so on. 

1. Select cells A3:D12. 
 

 

2. Click on the Insert ribbon tab and choose a graph such 
as the Column, then a subtype. 

3. You can make changes to your graph in two ways: 

 
• Double click on a part of the graph and watch the 

extra menus show up at the top. 
• Right click on a part of the graph and choose an option. 
• If you want to change the chart type, click on the Change Chart Type button on the Chart 

tab on the ribbon.  
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Exercise 
 

Open CLASS MARKS.XLSX 

 

1. Create the following graph: 

 

 
 

2. Change the colors of the bars. 

3. Experiment with the different types of graphs by changing the Chart type. 

4. How else can you change the look of the graph? 
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Excel Level 3 (Beyond the Basics Day 2) 

Working with Long Lists 

Open INVEST DATA FOR MERGING.XLSX 

Freezing panes 
 
If your spreadsheet is either wide or long and contains headings, it is hard to see the headings when 
you scroll onto another page. Therefore, it is difficult to tell which cells go with which headings.  
 
In this spreadsheet, when you are looking at the last column (column L, you probably can’t see the 
names of the people anymore, which could be a problem! 
 

 
 
To prevent this, we can freeze certain cells and heave them always appear on the screen, no matter 
where the cursor is. You can freeze columns along the side or along the top, or both. In this exercise, 
we will freeze the names on the left side (column B) and the column headings (row 4) on the top. 
 
The procedure is simple. 
 

1. Click on the cell below the row you want to freeze, and to 
the right of the column you want to freeze.  
 
In the above spreadsheet, you would click on C5. 

2. Click on the Freeze Panes button on the View tab. Choose 
the first option (Freeze Panes). 

3. Try scrolling through the screen and watch how the left columns and top rows never leave the 
screen! 

 
To make screen back to its original state, choose 
Unfreeze Panes. 
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Database Features 
 
You can use any area of an Excel worksheet to create a database and any worksheet can qualify as a 
database if it meets certain criteria. You can use Excel to sort database information in a specified order, 
present database information in a table, project and analyze database information and include 
database information in reports. 
 
The Data ribbon tab provides many tools to help you with your database. Some of these tools are on 
the Home ribbon tab as well.  
 

 
Defining a Database 
 
A database us an organized collection of information arranged in a row or column format, such as a 
telephone directory. You can use a database to store large amounts of information and retrieve all or 
part of the information as needed. You can enter database information using standard worksheet entry 
techniques, or into a data entry screen called a Data Form as discussed in a later section. Excel 
databases can also be used as data sources for Microsoft Word mail merges. 
 
All databases consist of fields and records.  A field is the smallest single item of information in a 
database, such as a person’s last name. A record is a set of one or more related fields that comprise an 
entry; for example, the full name and phone number for a person listed in a telephone directory 
constitutes one record.  

Guidelines for creating a database: 
 

• You must represent fields in columns and records in rows. Database information can include 
text, numbers, values, formulas and functions. 

 
• A list is part of an existing worksheet that you can use as a database because it displays 

information in a row and column format. It must contain unique field names in the header 
row, which is the top row. Field names, also called column labels, identify each column of 
data. You could distinguish the field names from the list data by using a different font, 
data type, alignment, format, pattern or capitalization style. 

 
• You must enter the first record for the database in the row directly below the field names. 

 
• You can use a cell border to further distinguish the field names from the database, but you 

cannot use a blank row or dashed lines. 
 

• The database must be separated from other worksheet data by at least one blank row or 
column. 
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Subtotaling 
 
You can easily get subtotals within your data. This feature does not work while your data is in a table so 
you must “Convert it Range” if it’s a table. This option is available in 
the Table ribbon tab. 
 
We want a report of the sales (Invest Amount) for each rep. 

1. Sort the column you want to subtotal by. In this case, the Rep. 

2. Click on the Subtotals button from the Data ribbon tab. 

3. Make the following choices. You want to “SUM” the Invest Amt 
column each time the Rep changes. You can also Count, 
Average, etc. 

This will give you a SUM subtotal the Invest Amt column for each Rep. 
 
 

 
 

You can get summaries by clicking on the 1 or 2 buttons on the top left corner of the spreadsheet. 
 

 

Removing the Subtotals 

You can remove the subtotals by going into Subtotal screen and clicking on Remove.
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Exercise 

Open INVESTOR STATUS.XLSX 

 

1. Let’s say you were going shopping for the gifts for these people. It would be handy to know 
how many fruit baskets to buy, and how many chocolates, etc.  
 
Do a Subtotal to COUNT each Christmas gift.  
 
(Hint, sort by the Christmas Gift column, then go 
into the Subtotals screen and choose: 
 
At each change in CHRISTMAS GIFT 
Do a COUNT 
of CHRISTMAS GIFT 
 
Don’t forget to click on the “2” when you’ve 
created your subtotalled list. 
 
This will be your shopping list!  

2. Remove the subtotals. 

3. Do a Subtotal to create a list of how much each 
Investor type invests.  

4. How many investors are in each state?   
Hint: I counted the INVEST AMT column, then hid the columns in 
between to get this printout. 

What other reports would be handy? 
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Making your Data into a Table 

Open Office Supply Sales.XLSX 

1. First test your data to be sure there are no blank rows or columns by clicking on one cell in your 
list and pressing CTRL A. 
 
This should select all the cells including the headers. 

2. Now choose Table from the Insert tab or press CTRL T. 

3. It will display a box listing what it recognizes as all the cells containing data, including the 
headers. Be sure that it recognizes that the first row contains header rows. 

 

Advantages of Creating a Table 

1. Always visible headers 

2. Automatic table extension. Enter below your last row and the table 
expands. Any formulas referring to this table you’ve used will now 
include the new data. 

3. Formulas automatically copy down, no need to autofill. 

4. Easy formatting. Click anywhere in the table and choose a Table style. 
 

5. One click select. Click at the top of the header cell or the left of the first cell to select all the 
data in that column or row. If you click again, you will select the header as well. 
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Sorting Data 
 
You can display database records in any order by sorting or rearranging the data. You sort information 
in a database according to the contents of a column or group of columns, called a sort key.  You can 
also rearrange the order of columns in your database. 

Simple Sorting 
 
It is very simple to sort by one column. Simply click on the column you wish to sort by 
(ie. Last name) and click on the sort and Filter button, and choose one of the sorting 
options, which depends on if you want to sort by ascending or descending order.  
 
If your data in is a table, you can click on the filter box beside 
each column header and sort by that column.  
 
NOTE: It is very important not to select any data and then hit 
the sort buttons, because it will only sort what you have 
selected and leave everything else as is!! 

Complex Sorting 
 
If you require a more complex sort, for example, you want to sort by more than one column (Last 
name, then first name), you need to use the Custom Sort screen. You also 
need to sort this way if you want to sort across, rather than down. 

1. Select a cell within your database. 

2. Choose Custom Sort from the Sort & Filter button. Sorting buttons are 
also available on the Data ribbon tab. 

3. Choose the first field you wish to sort by clicking on the down arrow 
beside each fieldname.  Choose which order it should be in. 

4. Click on Add Level and repeat the above step for each additional sorting level. 

5. By pressing the options button, you can choose if you want to sort it left to right rather than top 
to bottom. 
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Filtering your Data 
You can filter a database when you want to display or work with a subset of data.  When you filter 
data, you display only those records that contain a certain value or meet a set of search conditions 
called criteria.  Filtering temporarily hides records that do not meet the criteria you specify. You can 
remove filters to redisplay the entire database.  

1. Select a cell within your list. 

2. Choose Filter from the Sort & Filter button. Filtering buttons are also available on the Data 
ribbon tab. If your list is a table, you already have this feature turned on.  

 

This displays drop-down arrows to the right of the field names in the database. 

3. Click on one of the arrows to see all the different values in that field (ie. Item) 
 

 

4. Uncheck the (Select All) check box and select a single value (ie. Pencil), and click OK. 

 

5. Click on the filter arrow (right side of the column you filtered by) and choose Clear Filter from 
Item to get all the records back. 

Different types of filters: 

Text 
 

Number 

 

Date 
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Combining Filters and Subtotals 
 
You may have formulas and functions to display totals in your spreadsheet. But when you filter your 
list, you probably expect the totals to be the SUM of only the records you have filtered by, but they 
aren’t. They are still totalling the cells that you have hidden by filtering.  

1. Click on cell H2. 

2. Click on the fx button and choose Subtotal. Choose 9 as 
the function number  (see below) the same cell range as 
the first Autosum. If it’s a table, you can just select the top 
of the header cell. In this case, we will be totaling the 
Total column. 

 
 
This creates the formula: =SUBTOTAL(9,Table1[Total]) 

3. Apply a filter to the list and you will notice that the subtotal will adjust to sum only the cells 
that are visible.  

The following chart gives other alternatives. 
 

Function_num Function 

1 AVERAGE 

2 COUNT 

3 COUNTA 

4 MAX 

5 MIN 

9 SUM 

4. Create SUBTOTAL formulas for the rest of the cells in Column I (Average, COUNT, COUNTA) 
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Exercise 
 

Open SPAGHETTI MENU.XLSX 

1. Make the list into a table. 

2. Create subtotals formulas to calculate the Sum, etc.  

 

3. Filter by “Chicken” to display all items with Chicken in it to see the numbers change. 

 
 

Exercise 2 

1. Open CRUISEDATA – SUBTOTALS.XLSX. Create the appropriate functions. Then try filtering and 
watch the Subtotals change. 
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Pivot Tables 
 
A PivotTable is used as an interactive worksheet table that allows you to quickly summarize large 
amounts of data using the format and calculation method specified by you.  The name refers to the 
table's ability to rotate rows and column headings to access different views or perspectives of your 
data. 

Open US OFFICE SUPPLY SALES.XLSX 
Click on the Completed Sheet 

 

 
 
When creating a PivotTable, you will be asked to specify which data is to be summarized in rows 
and/or columns.  You can then specify which fields you actually want summarized. You can even filter 
this summary report, if desired. 
 
Fields are categories of data such as years or regions.  These data categories can be separated by rows, 
columns or pages.  If, for example, you were creating a sales report for the past five years, you might 
want to start each year on a separate page. 
 
These fields can be further broken down into items, which are essentially sub-categories.  For example, 
you may have a field labeled Year which can be grouped by each year. Each individual year is an item 
within the field called Year. 
 
The data to be summarized (such as sales) is referred to as the data area.  It typically consists of 
numeric values but can consist of text. 
 

  

Row Field 
(Rep) 

Column 
Field 
(Item) 

Values Field 
Converted to CDN$ 
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The arrangement of the fields within the table is referred to as the layout.  You can change the layout 
by dragging fields to "pivot" the table to a different perspective for viewing purposes. 
 
Like an automatic outline, the PivotTable is based on formulas, such as the SUM or AVERAGE function.  
Excel automatically uses the SUM function for numeric data and the CountA function for text. 
 
Excel offers two methods for creating a PivotTable. You can either choose from one of its 
recommended tables manually create the PivotTable yourself. 
 
Creating a Pivot Table 

1. Click in the data table to be used and then select this tool (located within the Tables section on 
the Insert Ribbon) to create a PivotTable.  
 
It is advisable to make your list into a table first! (CTRL T) 

 
 
The following dialog box will be displayed: 

 

 

2. You’ll be asked to enter the location of the data to be included in the PivotTable.  Excel will 
attempt to include the selected data table to be used. If it’s not correct, you’ll need to enter the 
correct table range. You can choose a group of cells within the current worksheet or specify an 
external data file. It’s a great idea to make your data into a table first, then the range will be the 
table name. This is handy when you add data to your table. It will be included in the pivot table 
automatically. 

3. You’ll also need to specify where the PivotTable will be placed (within the current worksheet or 
in a new worksheet). You will typically want to place the PivotTable in a new worksheet to keep 
it separate from the actual data being analyzed. This allows you to make edits (delete/insert 
rows and columns, etc.) without directly affecting the PivotTable. 
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4. When done, click .  The new PivotTable will have been added to your workbook, as a 
new sheet if that is what was specified in the previous step. 

5. Begin by dragging the name of the field you want included in the report to the different 
sections of your pivot table. Normally we start with the Rows area. 

To get this report, drag the fields to the following spots. 
 

 
 

 
 
Simply click and drag the field name off it’s spot if you want to remove it from the summary report.  
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To analyze your data in more detail, you can add a second field to the PivotTable to subdivide the 
totals even further by dragging the field to the “Row or Column Labels” section in the task pane. 
 
The diagram shown below was created by first selecting the “Region” data followed by “Rep”.   Notice 
how each region’s sales are broken down by rep. 
 

  
 
If you prefer to have your data grouped in a columnar format, drag your field to the “Column Labels” 
section of the task pane. 
 

Refreshing your Data 
 
When you make changes to your data, you’ll need to Refresh your Pivot Table. 

1. Click on the Pivot Table 

2. Choose Refresh or Refresh All from the Pivot Table Analyze tab. 

 

Formatting Values in a Pivot Table 

1. Right click on one of the numbers in your pivot table 

2. Choose Number Format 

3. Pick Accounting or Number, depending on which format you’d like 
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Grouping Your Data 
Sometimes your data needs to be grouped in order for it to become useful in a pivot table. For 
example, some spreadsheets only contain the date, and it’s not already broken down into years or 
months. You can, however, group your date field and request it to be broken down into months, 
quarters or years. 

1. Go back to your data sheet and click anywhere in it. 

2. Create a pivot table using the date as the column and the region as the row. Use Converted to 
Cdn $ for the Values.  

 

 

 
 
In newer versions of Excel, it will automatically group the data by year. If it doesn’t give you the 
breakdown you want, you can group it by Days, Months, Quarters or Years. 
 

3. Right click on one the dates and choose Group. 

4. Next you will see a box asking to break down your data into Years, Quarters, Months.  

Choose Years and Months. 
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5. You should now have 2 date fields in your Pivot Table field list. One is Years, and the other is 
Order Date (which is now Months). You can click on the – and + signs in your pivot table to 
collapse and expand the details. 

  

6. You are now able to move Years to the Filter box and choose a year to display if you’d like to 
summarize by month for a specific year.  

 

  
 
If you want it to summarize by year(s), you can remove Order Date from the Columns area. 
 

7. Experiment with the Grouping options such as Years and Quarters to see the various different 
reports you can get.  
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Displaying Averages, Counts, etc 
 
By default, if you drag over a field that has 
numbers in it, Excel will assume that you want to 
add (sum) them. It’s easy to change if you would 
rather have it perform a different function. 

1. Right click on one the totals  

2. Choose Summarize Values By and choose a 
function 

 

 
 
 
You could display more than one column of information as well if you drag the field over multiple times 
and change each one. It is best to not have a field in the Columns spot when doing this. 
 
You can edit the heading cells to be more meaningful and less busy as well. 
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Displaying Percentages 
 
Sometimes you may want to compare your data to the grand total.  
 

  
 

1. If you want both the columns as displayed above, drag the field 
you’re interested in twice to the Values section of the Pivot Table 
fields on the right of your screen.  

2. You will see the data displayed twice in your pivot table. Right click 
on one of the numbers within the column that you want to 
display percentages. 

 

3. Choose Show Values As….% of Grand Total 
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Creating a Pivot Chart 
 
You can insert a PivotChart (based on your PivotTable) to visually see the summary data within the 
PivotTable report, and to easily identify comparisons, patterns, and trends. By using a PivotTable as the 
basis for your chart, you can also quickly rearrange the data that is displayed in the chart. 
 
To create a PivotChart from an existing PivotTable, follow the steps outlined below: 
 

1. Be sure the PivotTable is active. 

2. Click this tool (located within the Tools section on the PivotTable Analyze Ribbon). 

 

 
 

3. The following box will be displayed. Select the type of chart to be created. 

 

 
 
 
If you’d like to change anything, click on the chart and choose from various options from the ribbon 
tabs you see at the top. 
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Exercise 

Open Pivot Table Exercises 

 

1. Starting on the first sheet, use the sample on the sheet to create the pivot table.  

2. Make sure you make each list a table first. 
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Advanced Functions 
 
In this module, you are introduced to some advanced 
functions that can be helpful when working with Excel. 
These include the COUNTIF and SUMIF functions. 
 
 
COUNTIF 

 
The COUNTIF function will only count the cells if the criteria are matched. 
 

Open INVEST DATA.XLS 

 

1. Click on cell L3. We are going to have it count how 
many people are 65 or older. 

2. Use the fx button to find the COUNTIF function. 

3. Click OK and fill in the following information.  

 
 
 
 

➢ range  Required. The range of cells that you want evaluated by criteria. Cells in each range must 
be numbers or names, arrays, or references that contain numbers. Blank and text values are 
ignored.  In this case, the ages. 
 

➢ criteria  Required. The criteria in the form of a number, expression, a cell reference, text, or a 
function that defines which cells will be added. For example, criteria can be expressed as 32, 
">32", B5, 32, "32", "apples", or TODAY(). In this case, if they are 65 or older. 
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If you are using text, you must be specific (ie. If you want to find all people who live in St. 
Albert, you must type in St. Albert. However, if you think you might miss some because of data 
entry inconsistency, you could type *Albert and it would count all cells with the word Albert in 
it.) 

NOTE: You can type a number into the criteria as above or a cell reference. If you type a cell reference, 
you need to put an ampersand in front of it to distinguish it from a number. ie. “>”&B16. Otherwise it 
will put quotes around it and consider it text. 
 
SUMIF 
 
SUMIF is similar to COUNTIF except that it will actually add up certain cells if it meets the criteria. 
 
In this next example, we will add up the investment amount from the seniors only.  

1. Click on cell L5 and find SUMIF from the fx button.  

2. Fill in the following information: 

 

➢ range  - Same as COUNTIF 
 

➢ criteria  - Same as COUNTIF. 
 

➢ sum_range  Optional. The actual cells to add, if you want to add cells other than those specified 
in the range argument. If the sum_range argument is omitted, Excel adds the cells that are 
specified in the range argument (the same cells to which the criteria are applied). In this case, 
the investment amount. 
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Exercise 1 
 

Open VACATION.XLS 

 
 
In the yellow cells, fill in the COUNTIF and SUMIF formulas for the questions asked. 
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Completed: 

 
 

Remember these spreadsheets have current data so the years of service and ages will be 
different in your spreadsheet than they were when this manual was printed! 

 
With Formulas: 
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Extra Exercise 
 

Open KIDS PARTY LIST.XLS 

1. Use COUNTIF and SUMIF to fill in the following yellow squares. 

2. Create your own inquiry for the last one! Be creative! 

 
Completed: 

 
With Formulas: 
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Worksheet Protection 
 
Occasionally you will want to protect certain cells in your worksheet from being changed or viewed. 
You can protect the whole worksheet from others looking at it with a password. You can also protect 
specific cells in a worksheet which prevents you or someone else from making changes to it. 
 
An example would be if you had confidential data that only specific people were allowed to see. You 
could force them to type in the correct password in order to view the spreadsheet. 
 
Or, if you had cells you wanted to protect that contained formulas or data that no one should be 
allowed to change, you would protect just those cells. 
 
Open and Save Passwords 
 
To prevent your worksheet from being opened by unauthorized users, you can assign a password to do 
it. 
 
In this exercise, you will assign a password to a confidential document. 
 

Open STUDENT MARKS-WORKSHEET PROTECTION.XLS 

1. Click the File menu, and then click Info.  

2. Click Protect Workbook, and then click Encrypt with 
Password.  

 
 

 

3. If you want reviewers to enter a password before they 
can view the document, type a password in the 
Password box. 
 

REMEMBER THAT PASSWORDS ARE CASE SENSITIVE! 
 
THERE IS NO WAY TO RETRIEVE A PASSWORD 
PROTECTED WORKSHEET IF YOU FORGET YOUR 
PASSWORD! 
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Protecting the Worksheet 
 
You can protect a sheet to prevent other people from changing its contents. You have the choice of 
protecting the contents of the whole sheet or just certain cells within the sheet. In this example, we 
will only allow the user to type in student marks (columns B - E). 
 

 
 
 
• On the Home ribbon tab, click on Format. 

 

To protect the entire sheet:  

1. Click on Protect Sheet. 

2. Click on OK. Note that there is an option to assign a 
password and specify what changes are allowed. 

3. Try to make changes to one of the cells. 
 

You are not able to make changes to any of the cells. 
 

 

To unprotect the entire sheet: 

1. Click on Unprotect Sheet in the Format button on the 
home tab. 
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Protecting Cells 
 
You can protect specific cells from being changed by first locking them and then turning on the 
protection as described above. Then you can turn protection off if you want to make changes and turn 
it back on when you are done. 
 
As a default, all cells are locked. You must unlock the cells you want to be able to change. In this 
exercise, we will unlock the cells where we will type the students’ marks. 

1. Click on Format button on the Home ribbon tab. Notice this LOCK CELL button is already turned 
on. 

2. Select the cells you want to be able to type in (numbers in columns B – E). In 
this case, many of the cells contain formulas. Select the cells that will contain 
the student marks. We have shaded them.  

3. Click on the Format button on the Home ribbon tab and click on LOCK CELL 
to turn it off. 

4. These cells are now unlocked. The rest of the cells on the sheet are already 
locked by default. You must now protect the sheet in order to have the 
locking take effect. 

5. Click on Protect Sheet and click OK. You can see that there are many levels of 
protection. For example, you may want to allow the user to make the 
columns bigger if they type data that is too small for the column. 
 

 

6. Type in a mark for the first student. It should allow this change. 

7. Now try to type over the Average or Passing Comment. It should not allow you to change these 
cells. 

When you have protected a sheet, press the TAB key to take you through the 
available cells! It will cycle you through all unlocked cells, which make it a super data 
entry key to remember! 
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Exercise 
 

1. Open BANK DEPOSIT-BLANK.XLS. 
 

2. Unlock the cells where you want to type into. They may already be shaded to help you out. 
 

3. Protect the sheet. 
 

4. Type into the shaded cells. You should be able to type there. Now try typing over some other 
cells, such as the formulas. You should be stopped from typing into those cells. 
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Making Drop Down Lists 

1. Enter all the possibilities onto another sheet. 

2. Sort them. 

3. Make them into a Table (CTRL T). 

4. Select them and give this range a name by clicking in the 
name box (top left corner) and typing in a name – no spaces 
allowed! 

5. Then select all the cells where you want the drop down list to appear and go into the Data 
Validation button from the Data ribbon tab.  

 

6. Choose List in the Allow box. 

7. Click in the Source field, and press F3. This will list 
all the named ranges and you can pick the range 
you named earlier! 

 
 
 
 
 
Now you’ll have a list to choose from! 

 

Exercise: 
Open invest - data validation and follow the instructions.  
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Quick Keystrokes 

ALT ENTER Forces a hard return or a line break in a cell cause the text to word 
wrap in a column. Handy for long titles. 

SHIFT ENTER  Completes a cell entry and selects the cell above 

CTRL ENTER Completes a cell entry and keeps the cursor in that cell 

CTRL - Deletes/Removes whatever you have selected (ie. Row, column or 
prompts you if you have neither selected) 

CTRL ~ Alternates between displaying cell values and displaying formulas 
in the worksheet 

CTRL SHIFT ! Formats selected cells to Comma style 

CTRL SHIFT $ Formats selected cells to Currency style 

CTRL Y or F4 Repeats the last command 

CTRL Z Undoes the last command you did 

F1 Brings up the Help screen 

F2 Takes you into EDIT mode so you can edit the contents of the 
current cell 

F3 Brings up a list of names of ranges in the spreadsheet. You can 
then double click on one of them and it will place the name in the 
formula you are entering. 

F4 If you’re typing a formula, this makes the current cell reference in 
the formula absolute. If you keep hitting F4, it will toggle then and 
eventually remove the $ signs. 

F4 Repeats the last command 

F5 Brings up a “Go To” box listing named ranges and allows you to 
type in a cell reference in order to go directly to that cell 

ALT F1 Creates a chart of the data in the current range 

SHIFT F3 Displays the Insert Function dialog box 

ALT = Creates an Autosum Function 

CTRL T Creates a Table Using the Current Region of Cells 

CTRL D Duplicates Above Entry 
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MOVING AROUND and SELECTING CELLS 

CTRL  or CTRL ➔ or 

CTRL or CTRL   

Takes you to the last cell in that direction 

CTRL END Takes you to the bottom right corner of the data 

CTRL HOME Goes to cell A1 

CTRL SHIFT 8 or CTRL A Selects all surrounding cells 

SHIFT ARROW Selects one cell at a time 

SHIFT CTRL ARROW Selects from the starting point to the last cell in 
that direction 

PAGE UP/PAGE DOWN Moves one screen up/down in a worksheet 

ALT PAGE UP/PAGE DOWN Moves one screen to the left/right in a worksheet 

CTRL PAGE UP/PAGE DOWN Moves to the previous/next sheet in a workbook 

CTRL SHIFT PAGE UP/PAGE 
DOWN 

Selects the current and previous/next sheet in a 
workbook. 

CTRL SPACEBAR Selects an entire column in a worksheet 

SHIFT SPACEBAR Selects an entire row in a worksheet 

CTRL SHIFT SPACEBAR Selects the entire worksheet 

CTRL SEMICOLON Inserts the current date into the cell 

CTRL SHIFT SEMICOLON Inserts the current time into the cell 

CTRL SEMICOLON, then 
SPACEBAR, then CTRL SHIFT 
SEMICOLON  

Inserts both current date and time into a cell 

CTRL A Selects Current Region of Cells 
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Adding Up a Column or Row of Numbers 
 

 
These same steps work for AVERAGE, MIN, MAX and 

COUNT. 

 If you are counting cells containing text, 

do the same steps but type an A in after 

COUNT to make it COUNTA.  

 

=AVERAGE(D4:D11) 

=MIN(D4:D11)  

=MAX(D4:D11) 

=COUNT(D4:D11) 

=COUNTA(D4:D11) 

1.
•Click where you want the total to go.

2.
•Click the AUTOSUM button. 

3.

• It guesses which cells you want added.

• If it's correct, press Enter.

• If it's incorrect, click and drag over 
the correct cells with the white cross
and press Enter. Remember to 
include the blank cell if there is one!
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Understanding the Excel Cursors 

1. Selection Cursor: 

 
Click and drag to highlight multiple cells with this cursor, or 

click in a cell to select the single cell. 

2. Autofill Handle: 

 

Click and drag to fill in the other cells with content. It works 

differently depending on what you drag. For example, if you 

Autofill Jan, you will fill in the other cells with Feb, Mar, etc. 

3. Move Cursor: 

 

Click and drag the contents of the selected cell to any other 

cell. 

4. Selection Bar (I-Beam): 

 

Click to place the cursor into the Formula bar so that 

you can edit an equation or function. 

5. Column Width/Row Height Sizer: 

 Click and drag in between columns or rows to 

resize them. 

 

 

Double click 

when you see 

this arrow and it 

will automatically size 

your column or row to 

accommodate the 

largest entry! 

6. Select Whole Column or Row: 

 

Click right on the Column 

heading or Row number to 

select the entire Column or 

Row. 
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Excel Printing Cheat Sheet 

 

•Click on the Page Break Preview button on the 
bottom right corner of the screen.

•Drag the Solid Blue Lines to enclose the desired cells.

•To get back to Normal view, click Normal.

#1 To Specify What to Print, 
Set your Print Area!

•Click Page Layout button on the bottom right of the 
screen and type the text in the desired spot.

•To get back to Normal view, click on a cell, then click 
Normal.

# 2 To Add a 
Header/Footer

•Follow Above Steps for Header/Footer

•Type Page (if desired) and then click the Page # 
button on the Header/Footer toolbar

#3 To Add a Page Number

•Select Cells

•File Print

•Choose Print Selection instead of Active Sheet

#4 To Print Selected Cells

•File, Print
OR

•Page Layout Tab at top of screen

#5 To Flip it to Landscape 
or Portrait

•File Print

•Click Margins to choose Predefined
OR

•Click Show Margins (Bottom Right)

#6 To Modify Margins

•File, Print

•Change Scaling to Fit All Columns on One Page
#7 To Make it Fit Properly 

on the Page

•Click Print Titles on the Page Layout Tab at top of 
Screen

•Click beside "Rows/Columns to Repeat at the Top" 
and Click on the Row(s)/Column(s) to Repeat

#8 To Repeat Headings at 
the Top/Side of Each Page
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#1 

#2, 3 

Click Normal to get back 

to Normal 

#3 

#5 

#7 

#6 

#4 

Show 

Margins 

#8 

#5 
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NOTES: 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 


